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4| Event Viewer — =
Built-in account for guest access t... . . - . e . . . . °
12| Shared Folders )L} ‘) u‘ ul.a.’».la.u Oﬁgcéwﬁ&‘akﬁ)sﬁ ‘5).3)5 g‘.)l.a.u} ﬁl.* 63)
v # Local Users and Groups Guest Properties T >
| Users .Ja.&j‘
| Groups General Member Of  Profile "
&) Performance
:.l.- Device Manager * Guest

v 22 Storage
= Disk Management
_; Services and Applications Full name: || |

Description: Builtin account for guest access to the ‘

computer/domain

lser must change d at mext logon
User cannot change password
Password never expires
Account is disabled
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%% Defragment and Optimiz IR PasswondPohey \:| Account lockout threshold _
¢@ OneDrive = Dick C| - 1 Account Lockout Policy R ek 5
i Administrative Tools _ ;—j ’-“TE‘”'-'F' & Local Policies ;| Reset account lockeout counter after
@ Backup and Restore (Windowe 7) D This PC i Event Viewer | Windows Firewall with Advanced Seci Account lockout threshold Properties ? *
BB ok Mariagirent I Desktop - "":&' iSCS! Initiator | Metwork List Manager Policies Local Secutty Seiting | Explain
= -1 Local Security Poli | Public Key Policies
o i '—ﬂ Documents :, ty e o e O!CI,E - =B Account lockout threshold
< Date and Time h 7% ODBC Data Sources (32- _| Software Restriction Policies =q.
J iy 4 Downloads E ODEC Data Sources (64- =] Applicat.inn Cu:.m.trcl Policies
I@ G J\ Muzic 5‘ Potarrmance Moror g IP Security POI|F|e5 oln Local Fomp.ute
& Eas ccess C =T ] | Advanced Audit Policy Configuration Account will lock out after:
&) File Hist B Pictuse %prmt Management k| 2| invalid logon attempts
% File Histary s ) - -
3 B Vvideos (3% Resource Monitor
A Fonts 05 () s Services
¢ Indexing Options P (E) L4l Systern Configuration
B |ntel® HD Graphics = 8 Systermn Information
% e & AapEe - Data & Documents e )
(&) Java [a) Task Scheduler
" =¥ Metwork ,‘? Windows Firewall with Aj
€
&5 Language = pricds
\#& Windows Memaory Diagn
@ Mouse sd, Homegroup B
< £ > ||
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ML By Guest Built-in account for guest access t..
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&% Home Windows Upd ate -Z'_f-fl + 1 @& <« Windows Update » Change settings v & Search Control.. 0@
| : | | Update status Choose your Windows Update settings
No updates are available. We'll continue to check daily When your PC is online, Windows can autornatically check for important updates and install them using these
Update & Security @ for newer updates settings. When new updates are available, you can also choose to install thern when you shut down your PC,
pda curity :
2 Windows Update Impaortant updates
Check for updates %
= wind Defend |_&| Install updates automatically (recommended) W
W Windows Defender ™
View installed update history ; : . ;
_ Updates will be automatically downloaded in the background when your PC is not on a metered
T Backup Internet connection.
£2  Troubleshoot Update SEttlngs Updates will be automatically installed during the maintenance window,
We'll automatically download and install updates, except on Recommended updates
O Recovery metered connections (where charges may apply). In that case, [ Give me recommended updates the same way | receive important updates
we'll automatically download only those updates required to )
@  Activation keep Windows running smoothly. Microsoft Update
[] Give me updates for other Microsoft products when | update Windows
A Find my device Change active hours

Note: Windows Update might update itself automatically first when checking for other updates. Read our

it For developers Restart options

X Advanced options | oK | Cancel
&  Windows Insider Program L=
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i E-thcket #4478737951 - Contral Eurspean (150} __:|_H & Your Statement between 171008 and 10/30/08 E|E|E|
B bR P 16 | tedn H

Toch Memsge Heb Fle Tt Yiew Jooks Messsge

» X @ Q & & w - X © O

Dete Priutul Ay ERSE =
Raply  Reply Al Foresrd Pririt DClate Prevvions Pt Addrenses

Froem: Berdto Modandon

Dake: Thursday, Cctober 30, 2008 8:28 AM

Toe -

Subject:  Your Statement betwesn 1108 and 10/50/08
Attache  [[CfiStatment 08,zp (34,0 £5)

e
LF0 00 BRETTIOOT
Ferguson

Your lopin: dho fim e
Your prssword passINTA

Your creds cord bas been charged fo
W would ik
Amached 1o thas

Please prmt ot page 2 of the report copy attached this e-maid

To wse vour scket. simply prist it on & color prised, and vou are set to take off for the jounsey!
Knd regards 3
Dt Fuiton Abways ready to andwer your questions,
e 1
Bente Meclendon

JerBkoe Aawirve
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() SPAMfighter

S@\fighter
[T‘ | overvien

'y
w | Clients
=)

Filters

l ‘/I Settings

- Your SPAMfighter statistics
& ) Account Processed emails
% ) Blocked by SPAMfighter
Q Blocked by you

x

¥) Time saved (Total):
) Spam ratio:

Microsoft Partner Yersion: 7.6.131 O FAQ g Support

° 4

lient Statistics

C

0
1]
o

0 miry,

0%

- X

O Q@ % W Q@ =

SLOW.PC FULL-DISK DRIVER SPYWARE VYIRUS OUTDATE
fighter  fighter  fighter  fighter  fighter  fighter

w3 Quick tips
St

Click here

Community Statistics
92,209,763,652
81,206,350,271

15450 years
88 %
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SIS oot o Sk ol Sledll aiile aies Gl Scam ! St Joasl B8 4 Bl e Slaags 9,90 40 Jlaie slepl, Hoaxs
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44‘) J.m.":\s..\m‘j:u odu)..f)| wlu_iuum‘ScamJ*MI ol 8 J}wsa
S sl 0515 099 isleblte Cam) 4 a5 Sl alas
4| * |5 is - Message o@3
Message Developer =2 O

Dear Account User,

We are currently upgrading our data base and e-mail account center 1.e

Subject rlmrueyshh
homepage view. We shall be deleting old email accounts which are no langer LIS s =
active to create more space for new accounts users.we have also i
nvestigated a system wide security audit to improve and enhance our b
current secunty. T 3ust racanad this from s Fiand 111 PLE 5 COMMENT, VERY ORTANT FOR

In order to continue usiNg our Services you are require to update and
re-comfirmed your email account details as requested below.

To complete your account re-comfirmation,you must reply to this email Itis
immediately and enter your account details as requested helow

0od to prevent

USBIMEME { ovvivrsmmisasans
E-mail Login ID.....cccoceee
Password ; .......

confirm password:
Date of Birth :.......
Future Password !

http://www.scamletters.com

Failure to do this will immediately render your account deactivated from
our database and service will not be interrupted as important messages may
as well be lost due to your declining to re-comfirmed your account details

@ to http://diamond-back.com

us.
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@ O http:/ifin.mail.yahoo.com/

From: Mr. Wong Du
Seoul, South Korea.

| will introduce myself | am Mr.Wong du a Banker working in a bank in south Korea Until now | am
the account officer to most of the south Korea government accounts and | have since discovered
that most of the account are dormant account with a lot of money in the account on further
investigation | found out that one particular account belong to the former president of south Korean
MR PARK CHUNG HEE, who ruled south Korean from 1963-1979 and this particular account has a
deposit of S48m with no next of kin.

My proposal is that since | am the account officer and the money or the account is dormant and
there is no next of kin obviously the account owner the former president of South Korea has died
long time ago, that you should provide an account for the money to be transferred.

The money that is floating in the bank right now is 548m and this is what | want to transfer to your
account for our mutual benefit.
Please if this is okay by you | will advice that you contact me through my direct email address.

Please this transaction should be kept confidential. For your assistance as the account owner we
shall share the money on equal basis.

Your reply will be appreciated,
Thank you.
Wong Du
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Google accounts

Change password

To reset your password, provide your current password OR the answer to your secunty question

o) Curreni password ssssssnss
OR
New password isnnssnnennennnnenenns  Cassword strenglh.  Stieng
Confirm néw password IsEsssESEssEEERRRRRRES

| Save || Cancel
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Add an alternate email address to your account

I ) oy vail. com

[Add an additional email address abedel@yahoo com ]

I_-Saue ] | Cancel |
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Don't have a Yahoo! ID?

Create New Account

OR

Sign in with
LJ
li Facebook ‘l Google

Sign in to Yahoo!
Yahoo! ID

& g freaZrhyme@yahoo. com

Password

Sign in with your
Google Account

Usemame

Password

Stay signed in

[~ ML

Cant access your account?

Eeap me signed n
{Uncheck if on a shared computer)

Sign In

Sign In

E-mail or Screen lame

Password

1[3 Remember Me l

Keep Me Signed In/Remember Me

Keep me LsLasd.:.gJ‘f I Ju.o.“ ‘_SLQCA..{)L{ )""“‘"“' C
.35,ls |, Remember Me _, signed in

Bydeo U aod oo o5l Juosl oS 4y a5 ol oy @
DS bk S Sledlbl saze (10,5 5 e &y 8 (S
25 sl 4 G AR o ol Ko olu)l5 a a5 ol @

Se 5l el a (g tws pla 1) o 557l b ol 57

ou;WMoMe&uleM;ﬁ
apa@kgut.ac.ir | 03433778508



HTTPS ;l oolasiu!

Settings chall doole <9 oo Jw‘ Lg).,)lf 6Lbul.w.‘> C
General Labels Accounts and impon  Eiledss Eonwarding and POPAMAP Chat Web Clips Labs  Priocty Inbox

Cifiioe  Themes Buzz Ls‘)" M; g_ia o).A.c 9 AOL Mall ‘YahOOInall

Language: Gmall displey | English (US _
splay language = . J o o . e
.Ju)‘a ;)9).9 Lasl LS‘)" ;ial.u) Liaj).a uL?t.u‘
# Enable Translieration - type usang phonstic Enghish - Lesm morg
Defaull transbieration languags: © ErHan .
@ Rightto-lah editing support off
Right-to.laft editing supporn on “ = . o c.e @
Maximum paga size: Shine B0 bivivkbe g g : T - * -
Show 250~ cotcs o pge HTTPS (HTTP Secure) Jsss,; 3l oslil
Keyboard shoricuts & Heyboard shorcuts off .
L o Keyboard shorcuts on -MQ )-:.:JJ
Extermal content: @ Abwoys display external content [such as images) sent by trusted senders - Legm more
Ask belore displaying external content
Browser connection: @ Alveays use hitps
Lan mooy Dant mhways use hitps
Conversailon View: @ Conversation view on
00 vkt Srmaly o e Sam Conversation view off

o e P et

@ ou;WMoMe&uleM;ﬁ
Cybersec apa@kgut.ac.ir | 03433778508




S5y 9 Mgy axio b 4 Gmall o g5 Ol Clled oy Gl
2SS SIS Details

|) Q'\ LgL(ac\.sL:;..; 9 O ygm aloladl ‘JBS..’;..Q cdlas Jr o live Syge

Send photos sasily from Grmail with Google's ltes phoals siganizen

Vou are curiently using O MB %) of your 7392 MEB.

wird scivlly: 24 minutes ago of this P (2

Liast s

SI00D Googls - Tarmhs - Privacy Polcy - Gobaie Horms

Cybersec <::::::::::::>

G Clas Cdlad o 15T (0,5 S
Adoed o ool g 10 (She rl OO e j0 Ojge )
WSS oy |y 6 )8 olee cdlad oy 5
by 9 b g (TP Luyol) CuBan (o e g ol jorr 5ol )5 59 50)

Activity on this account
This feaium prowdas misrmatan aboud the 61 actmty on ffed mal acoomt and ang concumani

wctiily. Laam mare
sccoun does [ i pther lecation. Howessr, [hare oy Be sessions Shal
hie been signed

| Sagn et all ot $essaons
a El ceni activiny:

| Aezess Type [ 7] [P aditrass [ 7 ]
| (Becwaar, mobie, PORI, wic.) |

| DadnTima
(Dusplaynd in Yoo limi zome)

FWRar " 238 pm (D mmutes ago}
T . ]
WEar —
st —
aar . ] e 28 [3 days ago)
j = m—

ou;WMoMe&uleM;ﬁ
apa@kgut.ac.ir | 03433778508



Joosl g Cawguy (40,5 (Sl

aS bles! el Cavgn 12 0,5 5L oK @
LS Sl L1530 528 U g oy (T S 51 oliiaal L eyd,S 5l 51 b 1, Lo 5 0 0,55 |, g (gla bl (sdon ®
&S o oSl | oglils g o sl (gaan j5055 55k 4 (g (T 05 JUb ¢

o - > ® u \3’
3 & ‘Funur
N N ar G o T e
. . . p , .t o B Extract files
B  Extract Here

Extract to Fun

. - , AF—

l Edt with Notepade « L
[P~ 4
. open e

w Restore pre

© Mem tentarSn rar

P Send to =

ou;WMoMe&uleM;ﬁ
Cybersec apa@kgut.ac.ir | 03433778508



Eile Edat | Wiew | Go Tools Adions Help

SAfiew = Liangs B v
wrrent i ¥
Mail
4 AutoBrev
Favonie Fold Subject
: | Inbax There sre
Fag Havigation Pane ]
Eept e
=] s&n Ta-Da Bar k
Mail Foiders
= Beading Pane LA Right
S0 Al Ml It

Reminders 'Windo

[}
|
i =
o .r_.-g| Toolbars v |l

o) DA G etatus Bar

@ Jun

& Dralts - Thunderbird

Be [dt il Go Messege  Took  Heb

£ 4 .
v TR - -~
bl wade view

All Folders Yartical Yisws
= &4 Local sort by ; = I
. M ¢ Magans Pa &
1 Message Pane F
= Uni  Hesders *
# Dré  Message Body As d
7w Display Attachments Inlne
] Tra
fed  Text Soe t
@ arh  Gharacter Encoding »
1 fu_t Message Soarce  Chrivl
) =
Cybersec Al e

ol Gy (SR 05 Shgels

55l eesl 5 sl Gl sl glpan T S Ll glacads @

DS Ghgels el slacandS jo 1y eesl (Shg o0l ©

SG oS 5L el aSol e cnl (See (Shg opl 0,8 JS L
2o Lyl g Sl oS

:Microsoft Outlook ,s jiols i S5y 50,5 (ogels slp ©

S okl |, Reading Pane g as9, View g 4
aS SIS Off a8 65,

:Mozilla Thunderbbird ;5 555l 0,5 (oges sl
A8 obksl | Layout ¢ wgp View s
S Jled e |, Message Pane a5

QL»,SGMMQMeLi&JbLJM;ﬁ
apa@kgut.ac.ir | 03433778508



$wlgsl b fos] 51 Gl Juosl (40,5 S

el (agein Lo S bl b sl pailesle ol s fasl 10,57 2ls @
Jugmsa oalaul M‘ (5[.@&).\.0." Lg.umo 9 LS’LIAJL&AA’ Lg‘)" YW J“"’"‘ LS‘LQJ.J.J C

G4 S (89, «Ng,p Delete group cwd 4 Home 50 0 Outlook2010 o «ilozl slo fs] 51 656l (ol ®

AS SUSAdd 455 (g9, Blocked Sender g5 o oS SIS Junk E-mail Options ... s Junk

Inbox -

| Inbax (5] @

Junk E-mail Qptions I

<7 Drsfts
-3 Sent Rems

\a] Deleted Rems

= Outbox
£ R55 Feeds

a

Cybersec

@ Junk E-mail [2)

Ja Search Folders

|

Feccouncilorg - Micrasoft Outloo

23 1 ta 3 Mo

& To Manager o P
33 Team E-mail g¥l One
~ s Bl ol o

= Facebook <notification+k|

© ine

Thu 2/10/2011 9:34 PM

Junk E-mail Diptions sccourcilony

Cptonm | Safe SErces Si.‘vih\mmi Boded Sendecs ill'.n‘l'\dhh

alg Emal from addresses or domam names on your Bocked Senders Lst vl
B sways e trested as ok e-mal

Rasdd nebrers o doman o

Enier an e-mal address or Infernet doman rame o be added
i e bt

2011 @gmed, com

Exampies: smeons Sexample.com, examge. oo, of
ELMTOMe, (0N

ou;WMoMe&uleM;ﬁ
apa@kgut.ac.ir | 03433778508



L feos | (Sl s (gLl
g oo 00wl iogaSTe S 0aiiS Lanel b ply SO onizin 3 Cugn wuli gl Jlazus slaladl ©
23S 158 eolaiwl 850 el 00,50 i ol Lol glgiore 4S5l Glaselsl gl ailgs o e

A3l s b ool Jlazms (slasl sl ool aolialss SO 4 )] )8
AS 8l o aslialsS jgas hawaie 51, Jlooms slalasl ailsd o

Ole! 50 aolodlss jauuo luwaio jl digei v ®

///f,ce'zz‘ Icert (https://www.icert.ir) Iranssl (http://www.iranssl.com) "3“58[

[T ij..}._’;.:{ pardazit(https://www.ssl.pardazit.net) Sarvssl (https://www.sarvssl.com) A

SARW SSL

Cybersec apa@kgut.ac.ir | 03433778508

© losS ixius oSS Edlans o8l LT oaass 35 50



JUazm s dolowles €l jo og

WSS ax>l o delinalsS jgae (hoate colw oy 4 ®

COMODO ¢ :

oS | sst +44 (0) 161 874 7070 . _
International +1 703 581 6341 i b i S S Q9LL) 9 (5)‘“”)’ ‘) JLM >0 O sl - 95 &_i) °

ComodossL  Wiidcard ss. [0 || FroeSSL  PKIMamager SSLUGC EVCodeSigning  Emaiaidentty Reselers Help

\ 4 : (| &l K], delinalsS alinalsS oo Loaie I

EV SSL - Extended Validation SSL Certificate =\ L
‘ : <°

Best for those who need:
'4 Green bar instant assurance

| Caol Juos| el sloaslinlsS 5l aiges S5 Comodo e
“ A2 &)1 alialsS salils (gl y |y casdes Sledlbl

provides immedinte ust and Nelps cusiomer conmwersion

ance SSL Cormicals, wilh 99.9% Browser Recopnition 43‘)‘ ML—?—Q‘; Q?J.;‘Q 'ﬁli& 45 055' M‘ LS)‘.’)lS ULM.?' 4.3 C
WS Sy wsols

‘d_aLz.s.mlﬁf was Soud svlive 1) 395 (S Bghio ©
DS sy g

@ QM;WMQMe&&JbgTM}Sﬁ
Cybersec apa@kgut.ac.ir | 03433778508




JUaz s aolaples S cuad

WSS S el SSd (59, Jlumms aslealsS coal (gl

| 15y ) e e yslenST CS 0l S 5550 50 0
Your Comodo FREE =g | Tools -> Internet Options -> Content tab
Personal Email Certificate | .
ey ot | 5 Sy S Ss Certificates asSs g9, Content tab o ©
- S SIS EXPOTt asS's (g9, g 0 obil | aslialgs @
i 0SS Next aeSs g5, ©
] ceo o co o iy = SS &, eS8 private key oss bl |, Yes e

SS cdadlxe (ol confirm g o gm0 S oyols L private key ;i ¢

O%e S oy Lﬂgoa; Sl ) O yemnST (gl 095 Hlai 0,90 Jl8 ©
.\.L:.;.S OJ.:.?"\S u0l>.

QM;WMQMembgTM}Sﬁ
Cybersec apa@kgut.ac.ir | 03433778508




B> o] 9355 Lol

29058 ) S &
. o . .| Microsoft Outlook -> File -> Option
S S sleaeSs (g5, i 0
Trust Center -> Trust Center Setting -> Email Security

I, Joso! Encrypted e-mail i 55,0 cewslio check boxes sl b @
DS (6585 5

oS SLUs Export L Import aaS's g9, ©

S g 1y Jlzss b awli 5 5 yqm 5 38 54 1, Lol Browse asss Gl ¢
S SIS OK aas's (g5, ©

1S SIS New Mail asS's (5, oy G (s sl @

ab aalys el ply (518550, send asSs (59, SIS 5l ey ®

(25,05 private key a5 1) ass’ IS Send Unencrypted aoSs gq, ©

- A8 SUs Continue asSs g, o)l Private key oo .5 51 @

QM;WMoMe&&JbgTM}Sﬁ
Cybersec apa@kgut.ac.ir | 03433778508




B> o] 9355 Lol

“ﬁunfnm |

il
! Eracrypled m-riiail
DER S#tlin
.P 5 Ererypd combands and aachments for cabgning mesiages
L Crplsain 1] Afd dhgital signsture Eo cubgoirg m

o

heat Lt

eql SMIME recaiph fod a8 SBIME

S Sptuy gred mevkade whar seriding tighed mestage

vl mEsiage

Lettinga.,

Dagital B (Ceriifcates)

X S s L R T
Wl et a5

g
¥ Oigetalifa s sates sre documents that aliow you to prove your sdenbty m eledironi transactions HI o
FrOQrAMmALIc ALess 2 [ . T g
Imoortnont... ||| Geta Digital 10... =
. — v, @
=

Rt @ Plaser Tewt

Fead all standaid mall i plain test

" -
Scrpt o Folders
Afow 5 € in shared Tolders
Ablow 3 in Pubfec Fobdess
e b bl s Snr e s siow | Laimm v - ¥ o 118 (8

oK Lencel

oLo,SWMQMe&%bIJM}Sﬁ
Cybersec apa@kgut.ac.ir | 03433778508




Cybersec

AS bl 1) a5 s 4 ax¢5 b g oS SIS Automatic Download isw o9, JTrust Center isw o ©

OTrust Center

Trusted Publishers

Attachment Handling
Automatic Download
Macro Settings

Programmatic Access

You can control whether Outiook automatically downloads and displays pictures when you open an HTML e-mail

meisage

Blocking pictures in e-mail messages an help protect your privacy. Pictures in HTML g-mail can réquire Outlook to
download the pictures from a server. Communicating to an external server in this way can venify to the sender that your
e-mail address is valid, possibly making you the target of more junk mailings

¥ Don't download pictures automatically in HTML e-mail messages or RSS items

v

e T e T

Permit downloads in e-mail messages from senders and to recipients defined in the Safe Senders and Safe
Recipients Lists used by the Junk E-mail filter

Permit downloads from Web sites in this security 2one Trusted Zone

Permit downloads in RSS items

Permil downloads in SharePoint Discussion Boards

Warn me before downloading content when editing, forwarding, or replying to -mail

Cancel

oo yS (s (oSS Mmas ol &l LT oawai 35 w0

apa@kgut.ac.ir | 03433778508



a

Cybersec

Read our blog at
Tumbsir

Try Lockbin Mobie!
it's freel

Donate

= - SEEE

&aa EEN]
HIPAA-comphiant
secura f3ong with

digital signature.
Fraee Triall

—

S oo 0dlaiwl )5 5 S Sledlbl g (5 Lael &,I5 Sl aile dile e SleMbl Lyl (gl pinn ]

Free online email encryption

Enter your message and password

e
eccouncil201 1@gmail.com

ecc@eccouncil.org

wesses
asReee

B J U= EFEEJBR| Sy ~ Paagragh « Fontfamly = Fontsie
XKDBAG®& MY |EE i« | — 2 [

| 4

eai

b

aM;WMQMe&ZJbQTM}Sﬁ
apa@kgut.ac.ir | 03433778508



)9 g (ol (gl 4l 3l

ool s 5! 3]
-~ ™, (= e
- Comodo AntiSpam % McAfee SpamKiller
http://www.comodoantispam.com (e http://us.mcafee.com
}M” Netcraft Toolbar "V  Comodo Email Certificate
= &) http://toolbar.netcraft.com —% http://'www.comodo.com
- -
f PhishTank SiteChecker Mirramail Secure Email
L. 5 https://addons.mozilla.org F http://'www.mirrasoft.com
- [ — ]
Q_, Spamihilator Encryptomatic MessagelLock
' http://www.spamihilator.com , http://www.encryptomatic.com

@ oLo,SWMQMe&%bIJM}Sﬁ
Cybersec apa@kgut.ac.ir | 03433778508




)9 g (ol (gl 4l 3l

adMs>
el 0055 iz b ST easiiw b SO 5l Jlusus slasly Jobs bg, o Email (electronic mail) e

) Foeals Wlgh oo ploisgny iz 02,5 5L a5 Wil B sleasl (g5l il o (Blawsn) donad slo bl
DS oagﬂ

ol 3, (2 9 awlgSl sla Lol b )15 (689,9 Bgoio y0,80esl a3 Spamming

St 2Blg il g s SO A Lo slo 8,55 slesl b g, slaloze Hoaxes ©
SSS yhgel 3 1) 5 19,0 history g las s Cache ;0,5 SL @

Juosl ples 6l &6 0 150 s yo o Lol header oglils (gly add | of o yals closdass @
g o ool (aiogaSTs Sy 008 Laral by aly Sy oaiis 3 Cagsp Al (gl Jlmo slaladl ©

Do S (gixino o 3loans slSL13 T pavatd 3950

Cybersec apa@kgut.ac.ir | 03433778508

Electronic Mail
N (Email)




)9 g (ol (gl 4l 3l

% o) o> (g

. S oolitd BCC a3 31 B0 S 3 solans 41 o] Jo) p5in
. WSS 03 09 5 j9 0 50 15 395 8 59m Jf)-“'
. S o Ko B Jrot] (557 55 Lod 45 IS (ol el 5 y0 0lge 550 § 00iun b 6 s 3ebga sursll pobusly |, Lol
. S i Lo rag) 5 00 (it § it gl e oo D] Loyl 5

% 23S S Lo |y 095 53,9 B9

. e JI! T 4 0.1 55 sy 00lils ol | Lol 5 05 ool |, _oloading

DS Lael Jlizn s O jao a5 aaS oo Jloyl a1 ola ool

oloyS (Frio LSS SMuaxs "emloQi‘M'"}Sﬁ
apa@kgut.ac.ir | 03433778508



)9 g (ol (gl 4l 3l

Jlgo o b fos! (o p Iy (Sl Cond S

Sl pled (gl a5 00 155,k y0 Lo Jues Header sgbls 1y Jibge olodass
BSS 5k g Jlol e blge &,k 51T Sy Cangn sla b

0585 s cailoads oolin B e slaply b Jool by &7 o laSTd

Sl a5 Cayl 1 oF 5 965 cead bl (s ns STy

S Jld e 393 hlbge 590 50 1) polad Auled 43S

DS Loyl ool e SO T LT e uon! o5lasl zalS™ (sl s

355 Jlo)| ZIP 50 a5 1 oo slo L8

oloyS (Frio LSS SMuaxs "emloQi‘M'"}Sﬁ
apa@kgut.ac.ir | 03433778508




2

Cybersec apa@kgut.ac.ir | 03433778508

© losS ixius oSS Edlans o8l LT oaass 35 50



